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Dear Children,

Technology is paving the way for new changes in education. Today, it is 
expanding perspectives in knowledge, helping us grow as global citizens, and 
opening new doors before us. The 9th standard ICT textbook comes to you with 
these immense possibilities.

    It is expected that this textbook will be a friend that makes your learn-
ing interesting and creative. This textbook describes the possibilities of different 
fields such as graphic designing, word processing, presentation, spreadsheet, 
webpage designing, networking, and internet services. Software such as Calci-
um, GeoGebra, PhET, and similar software you come across will help you 
comprehend the concepts in all subjects deeply and promote practical experience 
in using them.

   This ICT textbook will certainly guide you, providing both wings to 
your imagination and light to your thoughts. As it explores new areas such as 
Artificial Intelligence in a simple and engaging manner, it will support your 
learning journey, making it easier to understand and excel in all subjects.	

			   With regards,

	 Dr. Jayaprakash R.K. 
Director 
SCERT
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Chapter 1 

Poster Images 

Colour, images, messages, and their arrangement are 
essential elements in a poster. The effectiveness of a poster is 
depends on how attractively these elements are presented.

	 Look at Figure 1.1. This is the kind of poster Sarah's 
group plans to prepare for promoting the fruit festival.

Sarah and her friends are planning to design a poster on the computer to promote the Fruit 
Festival, which is being hosted in school by the Environmental Club.

Image editing

Image editing is the process 
of enhancing or modifying 
an image's appearance with 
the help of software. Using 
image editing software, we 
can perform various tasks, 
such as improving image 
quality, removing unwanted 
elements, and adding new 
ones.

Figure 1.1 Sample poster
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What are the things included in this poster?

	� Images of different kinds of fruits

	� ................................................................................................

	� ................................................................................................

A poster that has the potential for effective communication 
is created when the text, images, and background are all 
appropriately arranged.

In previous classes, you have been introduced to Krita, 
a software that helps us draw, edit images, and design graphic 
products such as posters, banners, and collages. Similar to 
Krita, GIMP (GNU Image Manipulation Program) is an image 
editing software that is highly useful for graphic design tasks. 
Let's help Sarah and her friends create such a poster using 
GIMP.

To do this, the first step is to open GIMP and create a new 
canvas.

Let's  Create a Canvas
Open GIMP on the computer and create a canvas with 

a width of 600 pixels and a height of 400 pixels as described 
below.

    

GIMP  
(GNU Image 

Manipulation Program)

GIMP was originally known 
as the General Image 
Manipulation Program. It 
was created by Spencer 
Kimball and Peter Mattis, 
students at the University 
of California, as part of 
their academic project. In 
1992, it became part of 
the GNU Project and was 
renamed the GNU Image 
Manipulation Program.

	� Open the Gimp software.

	� Click File    New.

	�  In the window that 
appears, enter the 
required width and 
length for the canvas. 
(Figure 1.2)OK

	� Click the OK button
Figure 1.2 Create a New Image Window

Pixels

A pixel is the basic unit 
of a digital image. It is an 
abbreviation of Picture 
Element. As the pixel count 
increases, the image quality 
improves.

For Creating the Canvas
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Now that the canvas is prepared, have a look at the main 
window of GIMP that has just opened (Figure 1.3). Are the 
features similar to those in Krita software?

	 Which tools are available in GIMP that we used in 
Krita? Let's check the toolbox and complete Table 1.1.

Figure 1.3 GIMP main window

Tool box

Canvas

Layer  
Window

Tool Usage

Move to adjust the position

Bucket Fill

Table 1.1 Common Tools and their Uses in Krita and GIMP

Wilber

Wilber, the official symbol 
of GIMP, was created by 
Tuomas Kuosmanen, a 
Finnish citizen, on 25th 

September, 1997, using the 
GIMP software.

Have you completed the table?.

While preparing a poster, each element (such as the 
background, images, text, etc.) should be placed on separate 
layers. We’ve already discussed the benefits of this approach in 
previous classes.
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Look at the layer window provided in Figure 1.4. This 
clearly shows that when a canvas is created in GIMP, the 
background is placed in the background layer.

	 Let's apply a new colour to this background.

Right-clicking on any 
tool in the toolbox will 

display the other tools in 
that group.

Layers

Layers are transparent sheets 
that can be added on top of 
an image. When creating an 
image using image editing 
software, placing each 
element or part on separate 
layers allows for individual 
editing of each part at any 
time.

Figure 1.4 Layer Palette

Assign Background Colour
	 There are various methods to assign colour to the canvas 

in GIMP. The Bucket Fill tool is one such feature that can be 
used for this purpose. Will you explore the tollbox and find out 
what other tools can be used for this purpose?

	� Paintbrush

	� ................................................................................................

Look at Figure 1.5. The first step in creating our poster is 
to design a background similar to the one shown here.

	 This has been created by combining two colours. Using 
the Gradient tool in GIMP, it is possible to create backgrounds 
like this by adding multiple colours.

	 Use the Gradient tool to colour the existing background 
on the canvas as shown in the example.
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Fig. 1.5 Background with Two Colours Blended Together

Using the Gradient Tool to Apply Colour
	� Select the Gradient tool from the toolbox.

	� You can select Gradient from Tools → Paint Tools → Gradient or by pressing G on 
your keyboard.

	� Click on the Active Foreground & Background colour selection boxes and select the 
appropriate colours for the background and foreground.  

	� Click on the top part of the canvas and drag down to apply colour.

You have given a background colour. Now you can save 
the image. Click on File → Save, give the image a name, and 
save the project.

	 We need to add images to our poster. The images 
are being brought one by one onto the canvas, and they are 
provided in the Class_9 folder located in the School_Resources 
on the computer.

	 The first element to include in the poster is an image 
of fruits. To do this, we need to open the 'Fruits.png' image in 
GIMP, which is saved on the computer.

GIMP Project File

When a file is saved in 
GIMP, the .xcf extension is 
added to the filename. This 
format is specific to GIMP 
and serves as its project file 
format. Saving images and 
text as .xcf files ensures 
that features like layers and 
transparency are preserved 
for future editing.

To Open the Image in GIMP
	� In GIMP, click File → Open.

	� Next, select the image and click Open.

The image has now opened in a new window and can be 
added as the background.
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Images to the Canvas
We currently have an image open in GIMP, showing fruits 

placed on a white surface.

	 Now, look at Figure 1.6. The background colour of the 
image has been removed, and only the image part is included 
in the canvas.

	 Let's explore how this can be made possible..

Figure 1.6 When Image is Added to the Background

Various selection tools are available in GIMP to select 
the entire image or a specific part as per the requirement.

	 Observe the toolbox, identify the different selection 
tools in GIMP, and then write their names and uses in Table 
1.2. When the mouse pointer is placed over each tool, the tool's 
characteristics are shown as a tool-tip

Selection Tool Shortcut key Use

Rectangle Select R Select a rectangular region

Ellipse Select

Free Select

Fuzzy Select

Table 1.2 Various Selection Tools in GIMP
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The image part has been selected here using the Fuzzy 
Select Tool (U). 

The selection is based on a technique called Threshold, 
which decides how much of the similar colours, starting from 
the edges of the image, should be included in the selection.

Try removing the background colour of the fruit image 
using the Fuzzy Select tool.

To Remove the Background Colour of the Image

	� To remove the background colour of the image

	� In the Tool Options at the bottom of the Toolbox, enter the required amount in the Threshold 
field.

	� Click on the colour to be excluded from the image (here, click on the background colour). 
This will select that area.

	� Then, press the Delete key to remove this area.

	� To deselect the image, choose None from the Select menu.

The background of the image has been removed, hasn't it?

Figure 1.7: Image after Background Removal

Now, the image can be added to the canvas prepared 
for the poster. However, as we already know, if the image is 
inserted directly into the background, its position and size 
won't be adjustable later on.
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Therefore, you can insert the image into a new layer.

	 Try doing the actions mentioned below.

When Removing the Background Colour

	 We could remove the background because the image 
has an alpha channel. If the image is RGB-only without an 
alpha channel, you need to add the alpha channel first. To do 
this, right-click on the image layer in the Layers palette and 
select Add Alpha Channel.

RGBA Channels

RGBA is a colour model 
that represents colours using 
four channels. It refers to the 
colours red, green, and blue, 
plus an alpha channel. The 
primary colours Red, Green, 
and Blue are used to create 
various other colours by 
adjusting their values.  The 
alpha channel controls the 
transparency or opacity of 
the colour. You can view 
the RGBA channels in 
GIMP by going to Windows 
→ Dockable Dialogs → 
Channels (Figure 1.8). 

Figure 1.8 RGBA Channels

To Add the Image to the Canvas

	� Select the image with the background removed.

	� Click Edit → Copy to copy the image.

	� Select the Canvas Window, then click Edit → Paste as → 
New Layer.

	� Rename the layer by double-clicking on it, which will 
allow you to edit the layer's name.

[A new layer can also be created using the Create a new 
layer option in the Layers palette (Figure 1.9)]

Figure 1.9 To Create a New Layer

The image of the fruits has been added to the canvas.

Now, the size and position of the pasted image need to be 
adjusted in a way that fits the poster.
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Let's Align the Image.
When adding images to a poster, we need to decide how 

to arrange them. Keeping in mind all the components that need 
to be included in the poster, the size and position of each image 
must be determined. The Move tool can be used to change the 
position of an image, and the Scale tool can be used to adjust 
its size. Using these tools, now arrange the inserted image 
appropriately on the canvas.

To Adjust the Size and Position of the Image

	� Select the layer containing the image you want to resize.

	� Then, select the Scale tool from the toolbox.

	� Click on the image.

	� In the window that opens, enter the required Width and Height. (Figure 1.10)

	� Click Scale.

	� Then use the Move Tool to adjust the position of the image.

When using the Scale tool, you can also resize the image by clicking and dragging the square 
that appears around the image. If you want to change the width and height separately, you must 
Unlink the chain link next to Width and Height.	

Figure 1.10 Scale Window

The image of the fruits has been arranged on the poster. 
Don't forget to save your work in between.

Enhancing the Picture  
What are the ways to make the image included in the 

poster more attractive?
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Increasing the brightness and intensity of the colours 
in an image is one method for improving it. Changing the 
background colour according to the included images can 
also help make the picture more attractive. Try changing the 
Brightness and Contrast of the image as given below.

To Adjust the Brightness-Contrast of Images

	� Select Brightness-Contrast from the Colours menu.

	� In the window that opens, move the slider to change the 
Brightness and Contrast of the image (Figure 1.11).

Figure 1.11 Brightness-Contrast Window

The image has more brightness and clarity. If necessary, 
select the Background Layer and change the background colour.

	 Next, the image of the bottle is to be added to the poster. 
This image is provided in the School_Resources folder as 
Bottle.png.

	 Open the image in GIMP. Is it only the bottle?

	 Let's explore how to extract only the bottle from the 
image and place it onto the canvas.

The tool used to change 
the size, shape, and 

proportions of images is 
the Transform Tool.
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Elements to be Included in the Poster

We have finalised the elements to be included in the poster. So 
far, we have used two layers to add these. Provide the details 
of the images included in each layer of the poster you have 
prepared,  in Table 1.3. 

Layer name Elements
Background Layer Background
Layer 1

Layer 2

Layer 3

Table 1.3 List of Layers

Extracting a Portion from the Image
The Paths Tool (B) is a tool that helps in selecting a 

specific part of an image based on a defined shape and allows 
drawing shapes that can be manipulated using handles.

	 Use this tool to extract only the bottle part from the 
Bottle.png image and add it to the poster as a new layer.

To Select an Image Using the Path Tool
	� Open the image (Bottle.png) in GIMP and select the 

Path Tool from the toolbox.

	� Then, click repeatedly along the edges of the image to 
make a selection.

	� To complete the selection, press the Ctrl key and click 
when you reach the starting point of the selection 
(Figure 1.12).

	� Then, select the path of the marked area from the 
'From Path' option in the Select menu (this will 
complete the selection).

	� Use the copy-paste method to insert the image on a 
new layer.

	� Adjust the size and position of the image.

Figure 1.12 Image of the Bottle 
Selected Using the Path Tool

Figure 1.13 When the Bottle is 
Inserted into the Canvas
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In the poster provided as a sample (Figure 1.1), there are 
two bottles. Do we need to follow the same procedure for this?

	 The easiest way to do this is to copy the image included 
in the canvas and use it.

	 To duplicate a layer, simply right-click on the layer you 
want to duplicate and select  Duplicate Layer.

	 The duplicate layer can be renamed and used further.

	 Let's save the poster by adding a second bottle to the 
canvas.

	 We have included all the necessary images for the poster. 
Shall we now add the headings and messages?

Add Text to the Poster
The words and headings included enhance the 

communicative potential of the poster. They should be arranged 
in a way that suits the layout of the poster and emphasises the 
message.

	 Let's add the title FRUIT FEST to our poster. To do this, 
try the activities given below.

We can use Crop Tool to 
cut part of an image

Adding Text to a Poster

	� Select the Text tool from the toolbox.

	� In the Tool Options, set the font size, color, and font style. 

	� Click on the canvas and type the words (Figure 1.14)
Figure 1.14 When Text is Added to 

the Canvas

Text Shadow Effects
If the heading is displayed in three-dimensional, the poster 

will become more attractive. By coordinating shadows and 
light, it will be possible to give the images a three-dimensional 
effect.

	 How about making the message more appealing by 
adding a shadow to the title we've prepared?
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Applying Shadow Effect to Letters

	� Duplicate the text layer. 

	� Apply black colour to the text on the duplicate layer (select the Text tool and click on the 
text to access editing options). 

	� Move the black-coloured text behind the original text. (To adjust the position of layers, 
you can use the Raise this layer/Lower this layer options in the Layers palette. (Image 
1.15) 

	� Apply a Blur effect to the black-coloured text to enhance the shadow. For this, 	

	� Select the layer and go to the Filters menu Blur → Gaussian Blur → Click OK.

	� Then, use the Move tool to adjust the position of the text so that the shadow appears exactly 
as desired.

Figure 1.15 Raise this Layer/Lower 
this Layer Techniques

In the same way, you can include other messages on the 
canvas and their position and size can be adjusted.

Shadow and Light with One Click

We have now added black and white to give the text a 
three-dimensional appearance. Multiple layers were created 
to accurately add shadow and light. To achieve this quickly, 
we can use the Drop Shadow technique in GIMP. Follow 
these steps to add a shadow to the bottle placed on the canvas.

	� Select the Bottle layer.

	� From the Filters menu, select Light and Shadow → Drop 
Shadow.

	� In the next window, enter appropriate values for X, Y, Blur, 
and Radius, and click OK

Let's Draw Shapes
Look at Figure 1.16.  Some shapes have been combined 

to make the poster's background more attractive. Now, let's 
explore how we can create similar designs by combining 
shapes in GIMP.

We can use the Flip tool 
to change the direction of 

pictures or shapes
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Figure 1.16 The Poster to be Completed

In GIMP, using selection tools like Rectangle Select, 
Ellipse Select, etc., you can draw shapes and fill them with 
colour to create such designs. Please note that they can only be 
edited and improved if they are created on separate layers.

	 The text 'Eat well Live well' is included inside a 
rectangular shape. This shape can be created using the Rectangle 
Select tool.

	 Below is the method for creating a shape and filling it 
with colour using the Rectangle Select tool in GIMP.

To Create Shapes Using the Selection Tool

	� Drag and select on the canvas with the Rectangle Select tool.

	� Then, click on Color Selection and choose the appropriate 
colours.

	� Colour the selected area using either Bucket Fill Tool 
(Shift+B) or Gradient(G).

	� Adjust the position of the rectangle using the Raise this 
layer/Lower this layer techniques.

Different selection tools can be used to select and create 
various shapes on the canvas, fill them with colour, and 
complete the poster.

Image Editing - 
Job Opportunities

Today, image editing is a 
field with vast employment 
opportunities. There are 
job prospects in various 
sectors related to image 
editing, such as graphic 
designing for posters, notices, 
brochures, websites, visual 
effects in video games and 
movies, social media posts, 
e-commerce, and more.
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Now we have created an attractive poster in GIMP. Don't 
forget to save the file.

 Let's Export the Image
If the posters or images created in GIMP need to be used 

in other documents, the image must be converted from the 
project file to an image file.

	 Using the Export method in GIMP, it is possible to 
convert the created image to various image file formats.

	 Shall we export the poster we created as a JPG image 
file?

To Export the Image
	� Click Export from the File menu.

	� In the next window:

	 Select the folder where you want to save the file

	 Name the file

	 Click Select File Type (By Extension) and select the format 
you want to export (PNG image, JPEG image, TIFF image, 
etc.).

	� Then click Export.

Using the techniques we have learned in GIMP, we will 
expand the poster by adding the school name, logo, the name 
of the school website, and a QR code.

Let's Assess

 	 When trying to move an image included in the canvas using the Move tool in GIMP, if the 
background is also moving along with the image. What could be the reason?

a)	 The image could not be pasted into the canvas. 

b)	 The image was pasted into the background layer of the canvas. 

c)	 The Move tool is not working.

d)	 The image format is not supported.
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	 Which of the following is the project file format of GIMP?

		 A) XCF  	 B) PDF	 C) JPG 	 D) PNG

	 Which tool is used in GIMP to resize a portion of an image?

			  A) Scale Tool   		  B)  Move Tool  

			  C) Paths Tool  			  D) Fuzzy Select

Extemded Activities

1. 	Based on the chapter "Digestion and Transport of Nutrients" in the biology textbook, create 
a poster in GIMP for an awareness class on the topic "Bad Habits and Heart Health".

2. 	Prepare the cover page for the diary being created for the Environmental Club members of 
the school using GIMP.

3. 	Design the cover page in GIMP for a digital album that includes temples and cave paintings 
from the Gupta period, based on the chapter Land Grant system and Indian Society from the 
Social Science textbook.


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Chapter 2

Styles to Get it All in Style
“The beauty of spoken words, 
The beauty of written words, 
The beauty of country side, 

The beauty of the place where I live!"

Anu and her friends are preparing a Folklore Encyclopedia 
in LibreOffice Writer, which is to be published on August 22, 
Folklore Day.

They have collected descriptions of art forms related to 
rice cultivation, agricultural songs, agricultural tools used in 
the past, agricultural practices, and agricultural proverbs to be 
included in the Folklore Encyclopedia and have typed them up 
in LibreOffice Writer.

They are thinking about how to make the document look 
more attractive.

Now let’s make 
it beautiful

The content 
is ready.
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OCR to Input Text
	 There are many ways to input the content of a document into the computer without 
typing using the keyboard. One of them is the OCR (Optical Character Recognition) technique. 
OCR is a technique that recognizes the characters in an image file or scanned document and 
converts them into text. Tesseract OCR, GOCR, and EasyOCR are such software.

	 The gImageReader on our computer is an OCR application. If you convert the pages 
of a book into image files or PDF files and feed them to this software, the characters in them 
will be recognized by gImageReader and converted into text.

	 The method of converting the contents of an image file into text using gImageReader 
is given below (the image file named kummatti.png in the School Resources folder can be 
used for this).

	� Open gImageReader (Figure 2.1).

Fig 2.1 gImageReader Window

	� Click Files → Add images and insert the file you want to convert to text.

	� Click Select language in the Recognize all section and select the language of the text.

	� Then, click Recognize all.

	�   The characters in the image file will be available as text on the right side of the window.

	� Save the content as a text file by clicking Save output or copying the text.
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How can we help Anu and her  friends? Let's take a look.

Style the Documents
Today, we get to read many publications, both digital 

and offline, such as newspapers, magazines, etc. Have you 
noticed how beautifully and differently the contents of all such 
publications are organized? Each one has its own design.

Look at the features of the content in our ICT textbook.

	� All the headings have a common size, colour, and shape

	� All the sub-headings  are of the same style.

	� Paragraphs are arranged in the same pattern.

	� ................................................................................................

	� ................................................................................................

We have learned in previous classes how to make letters, 
paragraph, and pages attractive using Libre Office Writer. Let's 
take a look at that.

Complete the table below.

To give colour to the letters Font Color

To give background colour to the page

To arrange the distance between 
paragraphs
To arrange text according to the images 
and shapes Wrap

To give border to the table

Table 2.1  Formatting Techniques in Libre office Writer

Is there any easy 
method to make 

the document  look 
attractive?

When preparing a document with many pages, it is a bit 
difficult to format the content of each page separately. Moreover,
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Styles

We identify the headings in a book based on their font, colour, 
size, and distance from the margin. 

Libre Office Writer  has the facility to pre-define such formats 
for the contents of the document. 

Styles are pre-defined features of headings, paragraphs, and 
pages.

These styles can be used later in the document as needed.

If you later change the design of the headings,subheadings 
or paragraphs, you will have to repeat this operation on each page.

Instead of this, it would be easier if we could determine 
in advance what formatting techniques we use for each element 
of the document ( font, colour, size, distance from the margin, 
etc of headings, subheadings and  paragraphs) and then use it 
when needed. 

For this we use the technique Styles in LibreOffice 
Writer.

Let's Define Headings
A sample  document typed and prepared by Anu and her 

friends to be included in the Folklore Encyclopedia is given 

in the School_Resources folder as sample.ott. Let's see how 
to make this document attractive using the Styles technique in 
LibreOffice Writer.

The first heading in the file sample.ott can be formatted 
using the Styles technique as shown below. Open the file and 
do this activity.

ott file

OTT is a document template file in the Open Document Standard Format (ODF). When 
opening files in the ott format, they are available as unsaved files (Untitled). Therefore, it is 
advisable to save the file first while using such templates.
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To Format a Heading Using the 
Style Technique

	� Open the file sample.ott in LibreOffice 
Writer and select the first heading.

	� Click the Style Box at the left side of 
the formatting toolbar (Fig 2.2)

	� Then click Heading 1 to give style to 
the heading

	�  Save the file with a name.

Fig 2.2 Stylebox 
Window

What changes do you notice in the first heading when the 
Heading 1 style is applied? Click on the heading and check the 
formatting toolbar.  Complete the list based on your findings.

	� Font size - 18 pt

	� Font style - ............................................................................

	� ................................................................................................

	� ................................................................................................

Heading 1 is a style that defines some features for main 
headings.

When this style is applied, the software recognizes the 
words we have selected as a heading and applies the formats 
defined in the  style to that heading.

Similarly, LibreOffice Writer has various styles to make 
the contents of a document attractive.

Click More Styles in the style box and check the Styles 
window that opens and see which categories of styles are in this 
window (Figure 2.3).

	� Paragraph Styles
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Fig 2.3: Styles Window

	� ................................................................................................

	� ................................................................................................

	� ................................................................................................

	� ................................................................................................

Can you find out which category the Heading 1 style we 
used  belongs to.

Now, what if we want to give the Heading 1 style to other 
headings in the document?

Let's see how to give the Heading 1 style to headings 
using the Fill Format Mode in the Styles window.

The Styles window can be 
opened  by clicking on the 
Styles .<image>.  in the side 

bar or using the key F11.



Styles to Get it All in Style

29 Information and Communications Technology-IX

To Style Headings Using Fill Format Mode

	� Select the style to be applied (here Heading 1).

	� Click on Fill Format Mode (Figure 2.4) and select the headings to be styled.

	� Press Esc key to exit Fill Format Mode

Figure 2.4 Fill Format Mode

Now  give all the headings in the document the style 
Heading 1. Make sure to save the file.

Let's Change the Styles
What should we do if we want to  format a style that 

has been already prepared in LibreOffice Writer? Let's make 
changes in the Heading 1 style based on the instructions given 
below.

Fill Format is a technique that helps to give styles to different contents in a document. The 
Fill Format technique helps to easily give the same style to the contents arranged on different 
pages in a large document.

Fill Format
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To Change the Style

	� Open the Styles window.

	� Right-click on the style you want to change (here Heading 
1) and select Modify

	� In the window that opens, make the necessary changes to 
the current formats of Heading 1 (Figure 2.5).

	�  Change the design of the letters using the formats given 
below and click OK.

	� Font → Family : THUMBA, Size: 14pt   

	� Font Effects  → Font Color : Red   

	� Alignment → Center  

Fig 2.5 Style Formatting Window

Font Family : THUMBA 
Colour : Blue 

Size : 14pt 
Alignment : Center
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Now look at the changes that have been made to the 
document.

Changes have been  applied to all the headings that are 
given the Heading 1 style, right?

Once you give style to the headings, subheadings, or 
paragraphs in a document, you only need to change or edit the 
style  to change their formats on each page.

While preparing large documents or books, is it now easy  
to make refinement if we do like this?

Let's Create New Styles
Now, shall we create new styles to give our own design 

to the folklore encyclopedia?

Just as we can change existing styles in LibreOffice Writer, 
we can also create new ones. First, let’s decide which styles are 
needed for the document and what their characteristics are.

Decide in advance the formats for the new styles  
MyStyle1 and MyStyle2 to be created for the headings and 
subheadings in our document . Then record them in Table 2.2.

Style
Font

Alignment
Distance from 

the marginFamily Size Colour
MyStyle1 Center

MyStyle2 Keraleeyam
Table 2.2 Formats of New Styles

LaTeX
There are many software available today that help with 
desktop publishing. LaTeX is one of the most convenient 
tool for preparing scientific/mathematical articles and 
dissertations. LaTeX has the facility to create symbols and 
formulae that are needed while preparing scientific papers. 
TexMarker is a software that helps in preparing documents 
in LaTeX.

For Malayalam fonts, 
changes should be made 

in CTL Font

For headings 
MyStyle1, 

and for subheadings 
MyStyle2
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Let's see how to create a new style according to the 
specified formats.

To Create New Styles
	� To create a new style in the Heading section, open the 

Styles window, right-click on Heading in the Paragraph 
section, and select New.

	� In the window that opens, select the Organizer tab and enter 
the name of the style we are creating (MyStyle1).

	� Choose the type of heading (Headingl, Heading 2...) under 
Inherit from.

	� In the Font, Font effects, Alignment, Indents & Spacing 
tabs, make the necessary changes and click OK to save the 
style.

	� Now the style we created (MyStyle1) will appear below 
Heading 1.

	� Then, using the Fill Format Mode technique, give the style 
MyStyle1 to all headings.

Now try to refine the document by creating a new style 
called MyStyle2 for the subheadings. Note that MyStyle2 is a 
heading in the Heading2 section.

Don't forget to save the file.

Footnote (Foot Note/ End Note)

Haven’t you seen some hints or explanations at the bottom 
or end of pages in articles and encyclopedias during your studies? 
Footnotes are included to provide additional information, hints, 
and references about any terms mentioned in the document.

Let’s see how to give Foot Note/ End Note for the 
explanation of some words in the document.

For this, first we have to prepare the words for which 
footnotes/indices are to be given and their explanations.

Now find the words to be included in the foot note of our 
folklore encyclopedia and their explanations.

Create New Styles 
Using the Drag and 

Drop Method 

In LibreOffice, you can 
create new styles using the 
Drag and Drop method. To 
do this, select a paragraph or 
other content that you have 
prepared with formatting 
techniques and drag it to the 
Styles window. 

Then, in the New Style from 
the Selection window that 
opens, give the style a name 
and click OK. The  style 
will be added to the Styles 
window with the name you 
gave it. 

You can  use the styles we 
create using Load Styles 
from Template in the Styles 
action option in other 
documents also.
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	� Folklore .................................................................................

	� ................................................................................................

Follow the steps given below to include an explanation 
of the terms you find as a footnote.

To Insert a Footnote/Index Into your Document
	� To include a footnote/index in the document, click at the end 

of the word where the index is required.

	� Click Insert - Footnote and Endnote – Footnote.

	� At the very bottom of the page, a number 1 appears below 
a small line.

	� Type the notes or additional information there. 

The number 1 will also appear near the word you clicked 
to include the Footnote. Clicking on this number will take you 
to the explanation below. Clicking on the footnote will take you 
to the footnoted word.

To add footnotes to more words, just follow the same 
procedure. You can see that  the footnotes are arranged in 
sequential numbers.

What if you want to arrange them all together at the end 
of the document instead of adding explanations at the bottom 
of each page?

Click at the end of the word and select Endnote instead 
of Footnote.

Try to give Endnote to the words you found in the same 
way as Footnote.

The words and their explanations that need to be given 
Footnote Endnote in our document are given in the folder 
School_Resources by name footnote.txt. Complete this activity 
using this file.

Now, using the Header, Footer, Page Number, Page 
Border mechanisms that we learned in previous classes, design 
the folklore encyclopedia and make it stylish.

These can be done using 
Footnote or endnote 

Window.
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	� After placing the cursor on the first page of the document, insert a new page using Insert 
→ Page break.

	� Click on the part of the new page where the table of contents to appear and then click Insert 
→ Table of Contents and Index → Table of Contents, Index or Bibliography.

To Create Table of Contents
You must have seen the details of the contents of books 

and magazines listed as a Table of Contents at the beginning. 
The Table of Contents helps us understand the topics, subtopics, 
and their page numbers included in the book.

Typing and adding the Table of Contents is a  laborious 
task. Moreover, it is difficult to make changes in the Table of 
Contents when changes are made to the pages or adding and 
deleting new pages. 

LibreOffice Writer has a technique called Table of Contents 
and Index that helps us prepare the Table of Contents without 
typing and to automatically reflect the changes we make in the 
document.

The software creates the Table of Contents by recognizing 
the styles given to the headings and subheadings in the document. 
While creating a new style, select the correct heading style 
(Heading1, Heading 2, Heading 3) in the Organizer tab's Inherit 
from option which helps the headings and subheadings to be 
arranged correctly in the table of contents.

Prepare the Table of contents of the folklore encyclopedia 
using the hints given below.

Scribus
Scribus is a free and open-source desktop publishing software. Scribus 
can be used to make the page layout and design of magazines, books, etc. 
more attractive. One of its advantages is that it supports Unicode fonts. 
Many Malayalam newspapers in circulation today are using Scribus to 
design pages.

To Prepare the Table of Contents

In which page is the unit 
Web of Goodness?

Find it from the  
Table of Contents .
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To Edit the Table of Contents
The options update index, edit index etc. obtained when right-clicking on the Table of Contents, 
can be used to modify and format the table. 

If you uncheck "Protected against manual changes", you can directly format the Table of 
Contents.

	� In the window that opens (Figure 2.6), type the heading of the table of contents in the Title 
field.

	� Click OK.

  Fig 2.6  Table of Contents Window

From the Table of Contents to the Content
What are the features of the Table of Contents we have 

included?

	� When the mouse pointer is placed on any heading in the 
Table of Contents, a message appears.

	� The message indicates that you can go to that page by clicking 
on the part where the mouse pointer is, while holding down 
the Ctrl key. Clicking on the headings or subheadings in the 
table of contents activates the link to the page it belongs to 
and takes you to that page.  
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Press and hold the Ctrl key and click on other headings.

Find out what changes have been made to the Table of 
Contents to reach different parts/pages of the report when our 
document is converted to PDF.

Does your Folklore Encyclopedia look more attractive 
now? Hope you get it ready for publishing.

Let’s Assess
 	 In the seminar document prepared in connection with Gandhiji's contribution to the freedom 

struggle, the headings were given the style Heading 1. After that, the style was modified and 
the font color was changed to blue. What changes will have occurred in the seminar report 
now?

a)	 Only the first heading will have turned blue. 

b)	 All headings using Heading 1 will have turned blue.

c)	 Heading 1 in the table of contents will have turned blue.

d)	 No changes will occur.

	What type of style should be selected in the Inherit from option of the Organizer tab when 
preparing the table of contents for those that will appear as main headings?

			  A) Heading1  		 B) Heading2  	  	 C) Heading3 		  D) Heading4

Extended Activities

1.	 Create a new style called MyParaStyle for the paragraphs in the folklore encyclopedia you 
prepared. Apply this style to all paragraphs.

2.	 Prepare a class magazine using LibreOffice Writer by including the articles of the children in 
your class. Use the style technique to design the content. Include a Table of Contents showing 
categories and names of the articles on the first page.

3.	 In the Social Science textbook you are asked to prepare a short biographical book based on 
the lives of thinkers of 6th Century BC who propagated new ideas. Prepare such a book  in 
LibreOffice Writer and make it attractive using Style techniques. Include a Table of Contents 
and footnote in the document.


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Chapter 3

Let’s Develop Software! 

Don’t you know that it is necessary to drink enough 
water to maintain health and body hydration? Drinking water 
at regular intervals is essential in hot weather. We often forget 
to do so. What arrangements have been made in your school to 
remind you of this?

	� A bell to remind us to drink water.

	� Posters.

	� ...............................................................................................

Similarly, we have many occasions in our daily lives 
when we need to remember the time to do something . What 
methods do you usually adopt for this?

	� Write it down so that we can notice it .

	� Assign someone the duty to remind you.

	� Set an alarm clock.

	� ...............................................................................................

	� ...............................................................................................

The simplest way to do this is to use an alarm clock. 
Devices can do this accurately and without getting tired.
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What if your school had a self-operated water bell system 
to remind you exactly when to drink water? If you create such 
an application using a computer and connect it to the school's 
sound system, it would be convenient to remind all the children 
of the time.

	 How can we create such a software ?

	 Applications can be created on a computer using 
programming languages such as Java, Python, C++, etc., or 
block coding applications such as Scratch and PictoBlox that 
we learned in previous classes.

	 Let’s  make a digital alarm clock using PictoBlox.

Make an Alarm Clock
A digital alarm clock Application prepared using Pictoblox 

is given in the folder Alarm_ clock in School_ Resources by 
name  Alarm_clock.html. Open this file in web browser.

Set an alarm in the clock so that it works in a short time.  
Observe how the application works and complete the list given 
below.

	� When the flag is clicked , the clock works.

	� The time in the clock is the time on the computer.

	� ................................................................................................

	� ................................................................................................
Have you understood the working pattern of the alarm clock?  

The sprites to prepare this application are provided in 
the Alarm_clock folder in School_Resources. Examine these 
sprites and the application and record the function of each 
component in the table 3.1.

Block programming

Block programming is a method of creating computer programs using code blocks through 
the drag-and-drop method. In this, there is no need to memorize programming instructions. 
They are provided in simple language as separate blocks in the editors of this system. Block 
programming is a very useful system for beginners in programming. Scratch, Blockly, App 
Inventor, and Blockly are some block programming techniques.
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Sprites Function

Clock dial (clock.png) Functions as the background

Second hand (Second_handle.png) Moves clockwise every second.

Table 3.1 Sprites Used in the Alarm Clock and their Function

We have observed the operation of each component in 
the alarm clock. What about preparing a Water bell application 
of this model using the software PictoBlox on our computer?

There are two main steps in preparing applications.

1.	 Preparing the interface (layout designing): Prepare the 
application interface by including the necessary components.

2.	 Giving instructions (coding): Give the instructions 
necessary for the components  to work.

To Prepare the Interface
The first thing we need to do to create a digital alarm clock 

application on the computer is to prepare its interface.

	  Open PictoBlox and use the files provided in the Alarm_
clock folder to design the interface of our application as shown 
in Figure 3.1.

To Adjust the Position of the Sprites
When you have more than one sprite in the same position on the stage, you 
can use the go to front/back layer code in the Looks section to rearrange 
their order.

Save the file once 
the Interface is set.
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Prepare the Background of the Clock
	� Delete the existing sprite in PictoBlox.

	� Insert the sprite clock.png given in the Alarm clock folder and adjust it so that it is in the 
middle of the stage.

	� Include the sprite Hour handle.png as the hour hand and set the size to 50.

	� Select the sprite  hour hand and open the Costume Editor.

	� Use the Select tool to drag over the object and select it.

	� Then adjust the rotation centre (Pivot Point) that appears when you move 
the object so that it is the rotation centre of the hand. (Figure 3.1)

	� Adjust the hour hand so that the rotation centre of the hand is at the black mark in the 
middle of the clock dial (if necessary, move the dial to the layer immediately behind it).

	� Then, add Minute_handle.png and Second_handle.png as minute and second hands 
respectively to the dial as shown in Figure 3.2.

	� Include Alarm_button in the clock after adjusting size.

Figure 3.1 The Steps to Adjust the Rotation Center and Position of the Sprite

Giving Instructions (Coding)
The first phase of the application, the layout design, is 

now complete.
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The Centre of the Sprite

This is the small crosshair 
icon that appears in the 
sprite's costume editor. This 
is known as the sprite's Pivot 
Point.

 

The sprite rotates around this 
centre while using rotation 
commands

How can we move these hands according to the time on 
the computer?

Let's check.

Moving the Second Hand
	 Haven’t you noticed the movement of each hand in 

clocks? In this way, we need to move the hands of the clock 
we are preparing. For this, we have to give the necessary 
instructions to each hand.

Select the sprite Second_handle and click on the arrow in 
its direction field and rotate it clockwise (Figure 3.3).

What change do you see?

	 The second hand also moves according to the change in 
the direction point of the arrow, right? So if we give this sprite 
the instruction to change the direction point every second, can't 
we move this second hand?

	 How many degrees should the second hand move in 
one second?

	 Since the dial of the clock is circular, its angle is 360 
degrees. The second hand has to complete this circle in 60 
movements. So, we can understand that 6 degrees, which is 
1/60 part of 360, has to be changed every second (Figure 3.4).

Figure 3.2 
Digital alarm Clock 

Interface Model

Figure 3.3 
Direction Field of Sprite

Figure 3.4  Angle Measurements in Clock
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So, think of what instructions should we give to move the 
second hand.

Examine Figure 3.5 and with the help of operators, give 
instructions to the second hand of the clock.

To Include Time

To get the computer’s time 
in the PictoBlox project, you 
can use the block current in 
the sensing section.

 Examine and find what this 
block contains.

Figure 3.5 Instructions for Moving the Second Hand

Now, click on the flag and run the program. Did the 
second hand on our alarm clock start moving?

Now, give instructions in the same way and try moving 
the minute hand.

To Move the Hour Hand
We have completed the task of moving the second and 

minute hands according to the time on the computer.

The next task is to move the hour hand. What is the 
difference in the movement of the hour hand from the movement 
of the second hand and the minute hand in the clock??

The second hand and the minute hand move 6 degrees 
each. But the hour hand should move 30 degrees, which is  
part of 360 in an hour. In turn, it should move 0.5 degrees, 
which is  part of 30 degrees in a minute, according to the 
movement of the minute hand.   

For this, the equation given below can be used.

Point in Direction = Current Hour x 30 + Current Minute 
x 0.5

Give the codes given in Figure 3.6 to the hour hand and 
try to operate it.

Operators in 
PictoBlox

In PictoBlox the Operators 
tab contains blocks that 
help perform mathematical, 
logical, and string operations.

  

are some of the operators on 
the Operators tab.
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Fig 3.6 Instructions to Move the Hour Hand

Setting Alarm

All the hands on the clock have started moving correctly. 
The next step is to configure our clock as an alarm clock.

See how the button that helps to set the alarm works.

	� When you click on , you can set the alarm time.

	� The alarm works according to the set time.

When we click on the  button in the alarm clock 
we activated , a field for recording the time is displayed. What 
should we do to set up this type of field in our application?

	� We can collect the required information using the code 
 in the Sensing section. The variable technique 

introduced in previous classes can be used to store the 
collected information.

	� For example, we can create a variable called Hour for the 
hour of the time given for the alarm.

	� For example, we can create a variable called Hour for the 
hour of the time given for the alarm.

	Then, we can store the  we get from,  
in this  variable.

See Figure 3.7 and give instructions to the sprite  
to receive the alarm time.

Now, create another variable called Minute and complete 
the task of giving the necessary instructions for receiving 
minute.

To Collect Data from Outside

We can use the ask and wait 
code in the sensing section 
to collect data as input to the 
project we are preparing and 
also to provide a field for 
typing it.

Fig 3.7  Instructions to Receive 
Time of Alarm
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Remember that you can also use the block  to 
check if the alarm time is the same as the time on the clock.…

Let’s Include Sound.
We have completed the task of collecting the time required 

to set the alarm. Now, when the set time arrives, the alarm should 
sound. How do we add sound to our clock?

Open the Sound tab. Don't you see the option to include 
sound

When should the sound be played?

The alarm should be played when the time stored in the 
variable and the time on the clock are the same. Along with this, 
you need to give instructions on how many times the alarm sound 
should repeat. Look at the codes given in Figure 3.8 and give 
instructions to complete the activity.

To Store Information
Variables can be used to 
store inputs received for a 
project being prepared and 
to be used in the program. 
They can also be changed 
according to instructions. 
They can store information 
in the form of numbers or 
text.

Figure 3.8 Instructions for Adding Sound to the Alarm

To include sound
The Sounds tab in PictoBlox 
allows you to add sound to 
your project.

You can use sounds available 
from the software library, 
recorded sounds, or even 
upload sounds from your 
computer to the project. 

To turn on the sound, use the 
command

Now you have completed all the necessary steps for the 
alarm to work.

Now try operating the alarm. Discuss with your friends 
the necessary things to set up our digital alarm as a school water 
bell system and start measures to implement it.
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 Block Coding and Text-Based Programming

So far, we have been familiar with the programming method based on code blocks. However, 
in real workplaces, software developers mainly use text-based programming languages to 
create programs. Those who approach programming studies seriously should definitely practice 
text-based programming languages such as Python, Java, and C++.

Let's Get Acquainted with Coding Using Python

Python coding is also possible in  PictoBlox . What if we use a Python program to create an 
animation that can be run when the alarm rings on our water bell?

	� Start a new project in PictoBlox

	� Access the Python coding window directly from the project opening window or by opening 
the Python tab in Block Coding.

	� Delete the current sprite and add the background and sprite as shown in Figure 3.9 (the 
necessary imagess are provided in  python_ animation  folder in the School_Resource).

	� Add a costume called boy2 to the picture called boyl

Figure 3.9 When the Sprites are Added to the Python Coding Window in PictoBlox

When the sprites are added to the stage, some of the Python codes associated with them 
are generated in the script section on the left.
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Now, let's add the instructions needed to animate the sprite.

Type the Python code given in Figure 3.10 into your project, replacing the existing 
code, without any syntax errors.

Figure 3.10 Python Instructions to Add to the Sprite

Click the Play button to run the code. Save the project as alarm_ clock_ animation.

Discuss with the teacher how to add this animation to the water bell project.

Python
Python is a text-based programming language suitable for 
beginners in programming. It was created in 1991 under the 
leadership of Guido van Rossum. It is a very easy-to-learn 
language. Python can be used to make small games and at 
the same time A.I. based technologies. A wide range of tools 
and libraries are available in Python.

Syntax

Syntax is the correct structure of code in a computer language, similar to the rules of grammar 
in a language. In Python, the use of indentation and the use of symbols such as "" to organize 
code are part of syntax.
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Let's Assess

 	 When two sprites are included in Pictoblox as shown in the picture, the pigeon is behind the 
tree. How can the pigeon be brought to the front?

a)	 The pigeon can be brought to the front layer using the  
block.

b)	 The tree can be brought to the back layer using the  block.

c)	 Both answers are correct.

d)	 Both answers are incorrect.

	 What code should be given to move the sprite Earth shown in the picture in 
Pictoblox counter clock wise by 5 degrees per second?

			  A)   					     B)   	  

	

			  C)  					     D) 

Extended Activities.

1.	 Add bells to the top of the prepared alarm clock that move when the alarm sounds.

2.	 Turn the alarm clock into a clock that operates automatically at regular intervals without 
receiving input.


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Chapter-4

Data Analysis Made Easy 

You may have noticed that the chapter on ‘Demographic 
Trends in India’ in your social science  textbook states that there 
are significant regional variations in the population density of 
our country. The study of population density in a country is of 
great importance as the socio-economic factors of an area and 
its population density are interrelated. 

The study and analysis of regional variations in population 
density is a task that involves handling a large amount of data. 
We have understood that spreadsheet software can be used for 
analyzing such vast amounts of data and drawing conclusions 
from it.

“Population density is not just a statistic; it is a measure of our ability to share resources, space, and 
opportunities”.
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DATA

Data refers to raw and unprocessed information. It can take various forms such as numbers, words, 
images, or videos. When these raw data are organized and analyzed, meaningful information can 
be derived from them. By using this information, we can make decisions and solve problems. 
In today's technology-driven world, data holds significant importance.

Let us try to analyze the states of the country based on 
population density with the help of LibreOffice Calc.

For this, data related to the 2011 Census of India has 
been collected from the internet and organized into a file 
named Census_India_2011.ots, which is provided in the 
School_Resources folder. Open the file and observe the table 
(Figure 4.1). 

Figure 4.1 Population Ratio in Various States – Table 
(Source : www.census2011.co.in)

What information is in the table? 

	� The total population of our country based on its states. 

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................

	� ...............................................................................................

How many rows?  How many columns?
In LibreOffice Calc, multiple sheets can be added. A spreadsheet file with more than one sheet 
is referred to as a workbook. Each workbook can accommodate up to 10,000 sheets. Each Calc 
sheet can contain a maximum of 1,048,576 rows and 1,024 columns.
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In the given table, the population density for each state 
has not been recorded. 

	 As the first step of data analysis, we need to determine 
the population density of the states.

Let's Find the Population Density
How can population density be determined? We know 

that population density can be calculated by dividing the 
population of a region by its area. The file Census_India_2011.
ots includes the population and area of various states. From 
this, we can calculate the population density of those regions.

	 Using the steps provided below, calculate the population 
density of each state and record it in the 'Population Density' 
column of the table.

Density of Population

The average number of 
people per square kilometer 
of an area is the population 
density of that area.

 	

Population Density=Total Popullation  
Land area

To Calculate the Population Density of the States
	� Click on the cell where you want to enter the result (here, to find the population density of 

Uttar Pradesh, click on cell G2).
	� Type the formula to find the population density (=C2/F2) (where C2 represents the total 

population of Uttar Pradesh and F2 represents the land area - Figure 4.2).
	� Press the Enter key.
	� To find the population density of other states, instead of typing the formula in each cell 

where the answer is required, use the 'Fill Handle' option.
	� Give the file a name and save it.

(Instead of typing the cell address directly while typing the formula, it is enough to click on 
the respective cell.)

Figure 4.2: Method of Calculating Polulation Density



Data Analysis Made Easy

51 Information & Communications Technology - IX

When the population density of states was calculated, 
many numbers had long decimal places. We have learned 
in previous classes that the ROUND function or the Delete 
Decimal Place  option in the toolbar can be used to manage 
decimal places. 

Use the "Delete Decimal Place" option to round the 
population density to two decimal places.

Let's Categorize States Based on Population 
Density 

The situation often arises where data needs to be 
categorized based on specific criteria. Such categorization 
will make the data analysis easier. It will also help in quickly 
finding the necessary information. 

For this purpose, the states need to be divided into five 
categories. Please refer to Table 4.1.

Population Density Category States
Below 100 Very low population density
100 to less than 200 Low population density
200 to less than 400 Moderate population density
400 to less than 800 High population density
800 and above Very high population density

Table 4.1 Classification According to Population Density

Here, we need to find out which states are included in 
each category. 

	 There are several functions in LibreOffice Calc for 
classifying data. LOOKUP is a function that can be used in 
cases where data needs to be classified into more categories.

	 Let us see how to classify states on the basis of population 
density using the LOOKUP function.

	 First, we need to decide on the criteria for classifying 
data. Here, the criteria as per Table 4.1 should be adopted.	

Online Spreadsheets

Online Spreadsheets are 
now available, allowing 
multiple people in different 
places to use them 
simultaneously. Examples 
of such Spreadsheets include 
Google Sheet, Microsoft 
Excel and Zhoho sheet.
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To classify the data, perform the activities listed below.

Data Classification Using the LOOKUP Function
	� Enter the criteria for classification in a new sheet (Sheet2) as shown in Figure 4.3. This will 

be the LOOKUP Table. It can be defined as 'Criteria'. For this, 

	 Select the lookup table and click Data → Define Range.

	 In the opened window, enter "Criteria" in the box labelled "Name" and click OK (Figure 
4.4).

	� Then, select the cell where you want the result (here J2) and click the Function Wizard (fx) 
on the toolbar.

	� From the Function wizard window that opens, select LOOKUP and click Next.   

	� In the Search Criterion box, enter the cell address where the population density is recorded 
(here, G2). In the Search Vector box, provide the name of the lookup table defined as 
Criteria. Leave the Result Vector box empty (as shown in Figure 4.5).

	� When the OK button is clicked, the result appears in this cell (J2). Drag the fill handle to 
apply it to the remaining cells as well. 

	� Save the file by giving the classified row the header Classification.

Figure 4.3 LOOKUP 
Table

Figure 4.4 Define 
Range Window Figure 4.5 LOOKUP Function Window
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We have already classified the states based on population 
density using the LOOKUP function (Figure 4.6). Now we can 
complete the table Census_India_2011 (Figure 4.1) provided 
in the School_Resources folder by finding out which states fall 
into each category.

Figure 4.6: The Table Categorized Based on Population Density

How can we find out how many states belong to each 
category? For example, we can count how many states are in 
the 'Medium Density' category from this table. But is it practical 
to manually count this from a large data-set with many entries? 
Doing so increases the risk of errors. This task can be easily 
performed using the COUNTIF function in LibreOffice Calc.

	 This operation can be easily done using the COUNTIF 
function in LibreOffice Calc.

Let us Find the Number of States 

COUNTIF is a function that can be used to easily determine 
how many cells in a dataset meet a specified condition. This is 
very useful for data analysis and reporting tasks.

	 Use the COUNTIF function to find the number of states 
in each population density category in our table.
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Counting Data Using COUNTIF

	� In the sheet, prepare a list of data to be counted as shown in 
Figure 4.7. 

	� Select the cell where you want to enter the count and click 
Function Wizard → COUNTIF → Next. 

	� Click in the Range box and drag to select the cells from 
which you want to count the number (here, from J2 to J36 
in Sheet1) 

Figure 4.8  COUNTIF Window

Figure 4.7 List of Data

	� Then, in the Criteria box, enter 
the cell address containing the 
name of the group you want to 
count (here, the cell labelled Very 
Low Density).

	 	 Notice the changes in the 
Result box and the Formula 
box (Figure 4.8).

	� Now, click OK and try dragging down using the fill 
handle. (See Image 4.9)

Save the file.

Figure 4.9 Using COUNTIF to Find 
the Number

You are familiar with sorting data using the LOOKUP 
function and counting the sorted data using COUNTIF.  	
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Now, if specific data needs to be separated and stored in 
another table, how can that be done?

	 For example, what needs to be done to separate and 
display only the states with very high population density from 
this table?

	 AutoFilter is the method used to separate specific data 
from a table. 

Filtering Data 
Try using AutoFilter to separate the states with very high 

population density from our table.

Using the AutoFilter Method to Separate Data
	� Select any of the cells with headings (here Classification).

	� Select Data → AutoFilter. 

	� Now you will see that the    button  has appeared in the cells with headings. 

	� Then, click the button   in the cell titled Classification.	

	� In the window that opens, keep the tick mark of the required data only. (Here the tick mark 
of Very High Density is kept. Figure 4.10).

	� When OK is clicked, a list of only the states with Very High Density is displayed.

The data can be filtered by setting criteria in the order Data 
→ More Filters → Standard Filter. States in other categories 
can also be filtered and identified using this method.

Figure 4.10 AutoFilter Window



Data Analysis Made Easy

56Information & Communications Technology - IX

To Protect Sheets
	� From the Tools menu, select Protect Sheet.

	� Enter a password for the sheet in the Password box. Enter the password again in the Confirm 
box and click OK. (Figure 4.11)  	

	� Save the file.	

Let's Protect the File

Can we protect our saved spreadsheet files from 
unauthorized editing while still allowing them to be viewed? 
LibreOffice Calc provides a feature to securely store data without 
restricting the ability to open and view it. This can be achieved 
using the Protect Sheet option. 

	 Let’s explore how to safeguard data in a Calc sheet. 
Follow the steps below to try it out.

Check if it is possible to edit a sheet that has been secured 
with a password.

	 What if you need to edit the file? How can you do that? 
Find out.

	 Instead of protecting the entire sheet, you can also 
protect only specific cells. Find out how.

	 You must have realized that with LibreOffice Calc, it's 
easy to organize and analyse data. Make sure to save the file 
once you've completed your tasks.

Figure 4.11 Protect Sheet Window

Let's Assess

 	 What is the use of the Auto Filter feature in LibreOffice Calc?
a)	 To sort data based on specified criteria.
b)	 To display only rows that meet specified criteria.
c)	 To delete rows that do not meet the criteria.
d)	 To create a summary of the filtered data.

		 What is the usage of the COUNTIF function in LibreOffice Calc?

a)	 To count all empty cells in a range.



Data Analysis Made Easy

57 Information & Communications Technology - IX

Extended Activities

1.	 In the "School_Resources" folder, the file "Census_India_2011.ots" contains the literacy 
rates of all states in India. Create a new worksheet to list the names of the states along with 
their corresponding literacy rates. Use the COUNTIF function to calculate the number of 
states with literacy rates above 90% and below 70%.

2.	 Prepare a spreadsheet where the scores provided by the judges for each event in the School 
Kalothsavam are entered, and the grades are automatically displayed according to the set 
criteria.

3.	 Create a table in LibreOffice Calc for the students and the scores they received in a subject. 
Use the LOOKUP function to record the grade for each student in the table. Protect the sheet 
with a password.

	 Note: Lookup table. 

b)	 To count the number of cells that meet a specified condition.
c)	 To find the largest content in a cell.
d)	 To count all cells that contain formulas

		 What is the use of the LOOKUP function in LibreOffice Calc?
a)	 Search for a value in a row or column and return the corresponding value from another 

row or column.
b)	 Count the number of empty cells in a range. 
c)	 Sort data based on a selected column.
d)	 Protect cells from editing.

Score Grade
Below 40 D
40 to 59 C
60 to 79 B
Above 80 A


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Chapter 5

The Web of Goodness 

The collective effort of those who seek goodness is the 
primary reason for the progress we have achieved today.  We 
can accelerate progress only when we share our knowledge 
with others and incorporate their knowledge into ours.

This perspective has laid the foundation for many 
initiatives on the internet. Among them, stands the Wikipedia 
about which we have come across in the previous classes, as a 
prime example of a global repository of knowledge.

Features of Wikipedia

Wikipedia is one of the key systems we use for gathering 
information from the internet. What makes Wikipedia special? 
Discuss with your friends and complete the list below.  
You may make use of the resources available on the internet.

"Internet is an interconnected repository of information used for both good and evil.  It is our responsibility to 
use it solely for the betterment of humanity.”

Stephen William Hawking
(Renowned Physicist)
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Anyone can Edit !

Membership is not 
mandatory to make edits 
on Wikipedia, the IP address 
of the one who make 
editions will be displayed 
on Wikipedia.  However, 
obtaining membership 
and logging in to edit is 
considered a more desirable 
approach.

	� An encyclopedia created through the collaborative effort of 
numerous people.

	� Accessible to anyone with an internet connection.

	� Anyone can edit and modify.

	� ..........................................................................................

	� ..........................................................................................

	� Monitored by volunteers who are passionate for knowledge 
exchange.

In short, sharing information in a manner that is accessible 
to everyone, enabling people from different corners of the world 
to update the content, ensuring reliability through impartial and 
accurate perspectives and preserving information for future 
generations, all these qualities highlight Wikipedia as an excellent 
model for collaborative knowledge sharing.

Hope you have understood the importance of becoming a 
part of content preparation in Wikipedia. 

How can we attempt to publish valuable information, 
images and  activities  related  to the history of our school on a 
platform like this? If anyone who knows more about the school 
could update and expand the content consistently, wouldnt it be 
a valuable repository of knowledge for the coming generations 
? Definitely, isn’t it ?

There is a wiki exclusively for the schools in our state – 
Schoolwiki.  Let's see what all details of each school are available 
in the Schoolwiki and learn how to add and update those details.

Wiki

The term 'Wiki' is derived from the Hawaiian word 'WikiWiki', 
which means 'quick”. This word indicates that wikis are intended 
for anyone to edit. 

Ward Cunningham, an American programmer, created the first 
wiki, called 'WikiWikiWeb' in 1995.

Ward Cunningham
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Fig. 5.1 Schoolwiki home page

SchoolWiki

SchoolWiki (http://schoolwiki.in) is a school encyclopedia created and maintained by the 
collaboration of all schools in Kerala. It is built using MediaWiki, the free software from the 
Wikimedia Foundation, similar to Wikipedia.  The prime aim of Schoolwiki is to collect and 
share the creative works of students and the learning resources prepared by teachers.  The 
history and foundational information of schools in Kerala, the outstanding works from the 
State School Arts Festival, Digital Magazines of Schools etc., are being updated in SchoolWiki.

Let’s Explore Schoolwiki

Access the Schoolwiki page by typing the address 
http://schoolwiki.in in the browser.  You can navigate to the 
Schoolwiki page of a school by typing the name or code of the 
school in the search box at the top of the homepage.

Go through the page and find the following details -

	� Year of establishment of the school. 
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	� Email address

	� Educational district where the school is located

	� ................................................................................................
.................................

Note down the details you have found out in a notebook.

How about adding more information to our school page, 
including school history and pictures?

But, you need to be a member of SchoolWiki to add 
information and make corrections in SchoolWiki.  And E-mail 
address is mandatory while filling the online form for the same.

E-mail

E-mail is short for electronic mail. The first form of e-mail was published in the late 1960s 
by the United States Department of Defence over the ARPANET network. Ray Tomlinson, 
who developed the program for it, is known as the father of email.

An e-mail address consists of two parts, the username and the domain name of the service 
provider. For example in gourykrishna@gmail.com the username is gourykrishna, gmail.com 
is the name of the service provider.  

One's e-mail address is also the digital identity of that person.  It is considered as the primary 
point of contact while using online services.

Gmail(google), Yahoomail and Disrootmail are popular email service providers.

How to create an e-mail address? You can  create an 
email address using the general template given below.

To create an e-mail address
	� Open any e-mail service provider's website.

	� Choose a username.

	� Create a password..

	� Provide additional information as instructed.

	� Verify account.
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Become a Member of SchoolWiki

After receiving the email, you can use it to subscribe to 
SchoolWiki.   You may join SchoolWiki by following the steps 
given below..

To Become a Member of Schoolwiki
	� Click 'Sign up' at the 

top right of Schoolwiki 
home page (Fig.5.2).

	� In the form that opens, give the 
following details -

	� Username

	� Password

	� Confirm Password.

	� E-mail address  

	� Name 

	� Captcha 

Click on 'Create your 
membership' and complete the 
steps.

	� After creating membership 
check you e-mail and verify the 
Schoolwiki account.

Captcha is a method used to verify if the user is a human. 
It can often be scribbled letters or pictures or solving basic 
math problems. Its purpose is to prevent the creation of fake 
accounts using computer programs.

 Fig 5.3 Schoolwiki 
Membership Form

 Fig.5.2 – Link to Subscribe Schoolwiki

If the username exists, 
try adding a place 

name or house name 
along with the name.

CAPTCHA
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Once you are a member of SchoolWiki, you can add or 
edit resources by logging in with your username and password.

Adding and editing information in Wikipedia and 
SchoolWiki has to done very carefully and utmost attention.

SchoolWiki has included a 'Ezhuthukalari' link to 
practice wiki editing.  Let’s continue our activities there.

The ‘Ezhuthukalari’ in Schoolwiki

'Ezhuthukalari' is a page created on SchoolWiki for 
students to practice wiki editing.  In this, each student can 
create their own page.  Here, they can add their works and edit 
them. As this is a page for training purposes only, whatever 
is added by one will not be available to others. Click on the 
'സഹാായംം' link to know more about the 'Ezhuthukalari’.

Fig 5.4 – Ezhuthukalari link

Wiki editing only 
after the training in 

'Ezhuthukalari’
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Create a page of your own in the  Ezhuthukalari  using the 
details given below.

To Start a Page in 'Ezhuthukalari’

	� Open Schoolwiki and click on the link ‘Pravesikkuka’.

	� Log in using your username and password.

	� Click on the link ‘Ezhuthukalari’ seen on the left side of the page  (Fig 5.4).

	� Enter your name in the window that opens and click on ‘Pravesikkuka’  (Fig 5.5).

Fig 5.5 – To Start a Page in 'Ezhuthukalari’

	� Then, either type the required text in the box or paste the pre-prepared contents.

See the Fig 5.6.  It is a page opened by Gouri in 
'Ezhuthukalari'

Fig 5.6 – A Page Opened in ‘Ezhuthukalari'

You have also created a page like this, haven't you?  
Make your name Bold using the formatting techniques found 
at the top of the page. Then try the Italic format and save the 
page by    clicking the 'Save the changes' button seen below 
(Fig 5.7).
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Fig 5.7 – When Bold, Itallic Formats are Applied to the Text

Save the page.  Now take a look at how the front page you 
created looks good in Schoolwiki.

	 We have familiarised ourselves with how to edit 
Schoolwiki pages. ‘Moolaroopam thiruthuka’, ‘Thiruthuka’ 
options can  be used to edit Schoolwiki.  Here we shall use the 
option ‘Thiruthuka’.

	 To make further additions to your page, click on 
‘Thiruthuka’ at the top and make the necessary changes to the 
page (Fig 5.8).

Fig 5.8 - ‘Thiruthuka’ Link in the 'Ezhuthukalari’

Now, we shall see how to include a 
heading for the content in our page.  For 
example,  imagine we need to include a 
description of the school on our page. 
We need a heading for that,  right?  
Type the heading and then select the 
corresponding text. Then, choose the 
required option from the headings in 
the formatting toolbar. (Fig 5.9)

Fig 5.9 – Formatting Tools in Schoolwiki – Headings
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See the poster prepared by Gouri as part of the 
Environment Day celebrations, posted on her 'Ezhuthukalari’ 
page (Fig 5.11).

You can also add images to the page by clicking on the 
‘Chithrangalum Mediakalum’ icon in the formatting toolbar. 
Try it.

Fig 5.10 – link for adding images in 
Schoolwiki

Fig 5.11 – Image Added to the Page

We have practised how to add resources and edit 
Schoolwiki pages.  

	 We are now familiar with how to add and edit the 
articles and images not only in Schoolwiki, but also in other 
wiki initiatives such as Wikipedia.

	 Now, discuss with your friends and update your school 
page in Schoolwiki.  Take the teacher's help for this.

Good Additions only

You may now have a doubt 
about the errors that may 
occur while creating a page 
and also that deliberate 
editing may distort the 
article when data collection 
is done in a collaborative 
manner.

Enterprises like Wikipedia 
have a robust governance 
system in place. Incorrect 
content and updations will 
be deleted immediately. 
There is also a mechanism 
to permanently ban those 
who commit such misdeeds 
continuously. Such people 
are called Wikipedia 
Vandals.

How can I review 
and edit my page ?

Just open the 'Ezhuthukalari’, 
enter the name of the page and 

click on ‘Pravesikkuka’.
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We have discussed systems like Wikipedia and 
Schoolwiki, which collect and publish information and images 
in a collaborative manner.

Let's check what other systems are available on Internet 
to help you post information and images online.

Social Media
The advent of Social Media has created a revolution in 

the field of communication. They provide a platform to share 
resources and interact with others.

Which social media platforms are you familiar with? 
Expand the list.

	� Linked in

	� Youtube

	� Instagram

	� ................................................................................................

	� ................................................................................................

	� ................................................................................................

Fig 5.12 – Use of Social Media

LinkedIn is a professional 
networking platform. As a 
group of people working 
in the same field, it helps 
to share a lot of things. Its 
most important feature is 
connecting job seekers and 
employers. Users can create 
profiles that include their 
qualifications, experience 
and achievements.
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See the Fig 5.12.  Analyse the figure and discuss the main 
advantages of Social Media in your class and expand the table 
5.1.

Platforms Uses

Resource Exchange
Send text, images, video etc.

Networking
Contact with family, friends, colleagues etc.

Social Construct
Create social groups and communicate

Real-time Communication
Video calls and live telecast etc.

E-Commerce
Carry out Online transactions

Table 5.1 – Advantages of Social Media

One from Insta 
is inviting to 
meet directly.

Inform teachers 
and parents.
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Social media has a lot of possibilities. The interventions 
in them are to be made very carefully.   Pay attention to the 
following points.

Be Smart on Social Media...

	� We should check the privacy settings of the system we are using and configure them 
securely. Be careful when sharing personal information like address, phone number, date 
of birth.

	� Disrespectful behaviour should be reported and those individuals should be blocked. At 
the same time, we must be careful to be respectful in our interactions.

	� Don't spread fake news and misinformation.

	� Don't trust strangers you meet online and rush to meet them.

	� Screen time should be reduced and breaks should be taken in between. Recognize the 
signs of social media addiction and seek help if needed.

	� Information shared on social media should not be offensive or harmful to anyone.

	� Respect the privacy of others and do not share their personal information without 
permission.

	� If you have bad experiences from social media, you should share it with your parents, 
teachers and close friends.

Just like social media, the online transaction platforms 
used by most of the people today also require a lot of caution.

There was a time when the elders at home  would waste 
time queuing for bill payments, certificates etc., The time when 
such matters were dealt with and done directly! How easy 
and useful the online services have made life today, haven't 
they?	

What are Online transactions? Let's get to know the different 
types of online shopping methods.

Buy and Sell Online 

Online transaction is the buying or selling of goods or 
services online. Paying bills and exchanging money are part of it.
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Check some of the important online transactions given 
in table 5.2.  Discuss in the class to find out more details and 
complete the table.

Requirements Examples

Buying and Selling products online •	 amazon.com

•	 olx.in

•	 ...................................

•	 ...................................
Online money transaction •	 Google pay

•	 Debit cards

•	 ...................................

•	 ...................................
Online banking •	 YONO SBI

•	 Canara Digibanking

•	 ...................................

•	 ...................................
Online bills •	 Electricity (KSEB Quickpay)

•	 ...................................

•	 ...................................

•	 ...................................

Table 5.2 – Different Types of Online Transaction Platforms

Two-Factor Authentication - 2FA

Two factor authentication is a way to use an account on 
security-sensitive sites in addition to a password.

After entering the password, the account can be managed 
only by entering a one-time code (OTP) received on the 
phone or email address.
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So far, we have discussed some online services. The 
internet has become an indispensable part of our lives today.  
The Governments are making effective use of the Internet to 
provide services to the public in Education, Entertainment, 
Health and the like, 

You may remember the online classes and First Bell 
classes through VICTERS channel that were conducted and 
telecast during the time of unprecedented natural calamities 
and the Covid-19 pandemic a few years back.

SAMAGRA Plus is such an online initiative to reduce 
learning gaps among the students and to make learning 
interesting. 

The Learning Room in the SAMAGRA Plus digital 
resource portal under the General Education  Department 
Kerala, has additional resources with audio-visual techniques 
related to various subjects, assessment activities and self-
assessment tools. The SAMAGRA Learning Room is an 
innovative digital multimedia system designed to meet the 
learning objectives of all subjects covered in the curriculum.  

Let's see how to use the Learning Room system in 
SAMAGRA Plus.

Learning Room in SAMAGRA 
Explore the SAMAGRA Plus Learning Room using the 

details given below.

Fig 5.13 – Home Page of SAMAGRA Plus Portal

Debit Card is to use the 
money in our account. On 

the other hand, a Credit 
Card is a loan for a fixed 

period of time.
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Attention
We have seen advertisements on social media offering 
unbelievable discounts. Many of them are likely to be fake or 
of poor quality. Check the validity of online offers and avoid 
clicking on suspicious links.

	� Open the web browser on the computer and type https://
samagra.kite.kerala.gov.in in the address bar and enter the 
Samagra Plus portal. You can reach the Learning Room 
through the link called Learning Room.

	� Then, select your medium, class and subject and proceed 
(Fig 5.14)

Fig 5.14 – Select Subject in the Learning Room

PDF of textbooks available on each subject page.  Explore 
the Pages, Learning materials, Self-Assessments, Podcasts and 
other resources. 

You are familiar with how to use the Learning Room in 
SAMAGRA.

SAMAGRA Plus Portal Link
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Now, open the home page of SAMAGRA Plus Portal and 
check what all other features are available in it.

	� Question Bank

	� Podcast

	� ................................................................................................

	� ................................................................................................

Explore each one.  You can make use of it for your studies.

Have you ever thought of the systems that have made our 
lives so smart and easy with the advent of internet ! 

However, unfortunately the cyber world that we interact 
with daily is not of only good things. Just like the offline world 
we live in, there are criminals and evil in the online space too.

We should be well aware of the common evils in 
cyberspace so that we can identify them, avoid becoming 
victims of their evil act, and stay away from them.

Let's get acquainted with some important cyber crimes.

Cyber Crimes

Podcasts

Podcasts are audio messages 
on various topics. Even 
when we are busy with other 
things we can listen to them 
on our phone or computer, 
just like from a radio station! 
TED Talks Daily and Stuff 
You Should Know are some 
of the websites that have 
informative podcasts in 
English. All India Radio's 
Aakashvani podcast is also 
a popular one.

 Be cautious, it is 
definitely a scam 

message from 
fraudsters.

I got an e-mail that 
I have won lottery worth 
1 Crore.  They are asking 

for Rs.1500/- as processing 
charge.
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Malwares
These are computer programs that can enter our computers in 
various ways, leak information or cause damage.

Viruses and others enter our system through e-mails, downloaded 
files, USB drives etc. Precautions include following safe 
browsing practices, performing regular updates, being careful 
when using public Wi-Fi, and backing up important information.

Phishing
This category includes fake e-mails and messages from 

social media claiming you won the lottery, got a job, or won an 
award. The purpose is to cheat by leaking information including 
bank account.

Cyber Stalking
This is a crime of cyber-harassment by gathering 

information about us through social media or other means and 
using threats and blackmail.

Camera hacking 
The crime of stealing our private pictures and videos 

using the camera of a laptop or mobile phone by infiltrating 
with a virus or malware.

Crypto hacking
Crypto hacking is the crime of stealing digital currencies 

such as cryptocurrencies from our accounts, just like stealing 
our money or valuables from a bank. Most of these frauds are 
done through phishing and malware.

IoT attacks
Hackers can infiltrate IoT device networks to 

steal data and cause destruction, including misuse. 
Most of these attacks are carried out through security loopholes 
using malware or spy hardware.

As the cyber world evolves, new cyber evils and crimes 
will emerge. Therefore, understanding them and adopting 
preventive measures is crucial.

Digital Currencies

These are digitally 
exchangeable currencies or 
cash-like assets that work 
with the help of blockchain 
technology. All transactions 
of digital currency are stored 
in the digital ledger.

Examples are Bitcoin, 
Ethereum, and Litecoin.

Fact Checking

As the influence of social 
media deeply permeates 
society, one of the most 
dangerous aspects is the 
spread of fake news.  We 
need to learn how to 
identify and counter these 
fake news which are shared 
and made viral by many 
people intentionally or 
unintentionally.  Identifying 
and verifying the authenticity 
of the source such news is 
important. On receiving such 
a news it is essential to seek 
clarification from others, 
or use official channels or 
conduct a detailed search on 
the internet to ascertain the 
truth.
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Be Vigilant
We have seen some measures to avoid cyber attacks (Fig 

5.15). You amy divide into groups, gather information about 
these measures from the internet, discuss and present them in 
the class.

IoT - Internet of Things

Internet of Things or IoT is 
a technology that connects 
devices to the Internet to 
collect data, communicate 
and remotely control them. 

We need Secure 
Passwards

Share personal 
informations only on 

credible platforms Keep the system 
updated constantly

Refrain from using 
public Wi-fi for 

financial transactions Suspicious activities 
should be reported to 

the authorities

Be aware of and 
resist the latest 
cyber crimes

Fig 5.15 – Some Instructions for Cyber Security

As the famous physicist Stephen William Hawking 
reminds, we can become better digital beings by absorbing the 
maximum goodness of this cyberspace and transferring it to 
others.
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Let’s Assess

 	 What is the name of the software used to create Wikipedia, Schoolwiki etc., ?
a)	 Wikiwiki
b)	 Mediawiki
c)	 Wikimania
d)	 Softwiki

		 Which among the following is not a social media ?
a)	 Youtube
b)	 Schoolwiki
c)	 Instagram
d)	 WhatsApp

		 Which is a cybercrime that collects our information and threatens and blackmails us through 
social media?
a)	 Phishing
b)	 IoT Attacks 
c)	 Cyber stalking
d)	 Crypto hacking

Extended Activities

1.	 Add a review of any book you've read to the Ezhuthukalari of the Schoolwiki along with 
the cover page. 

2.	 Improve the 'My Village' page in the 'Projects' section of your Schoolwiki.

3.	 Watch the video 'Biomolecules' in the 'Towards Life Processes' unit in Biology available 
in the SAMAGRA Plus Learning Room. Then, answer the questions given in the 
Assessment. link.

4.	 Using the information you learned from this chapter and validated from the Internet, 
organize a seminar at the school to raise awareness about the Things to Keep in Mind in 
the Cyber World.


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CONSTITUTION OF INDIA

Part IV A
FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51 A
Fundamental Duties - It shall be the duty of every citizen of India

a)	 to abide by the Constitution and respect its ideals and institutions,the 
National Flag and the National Anthem;

(b) 	to cherish and follow the noble ideals which inspired our national 
struggle for freedom;

(c) 	to uphold and protect the sovereignty, unity and integrity of India;

(d) 	to defend the country and render national service when called upon 
to do so;

(e) 	to promote harmony and the spirit of common brotherhood amongst 
all the people of India transcending religious, linguistic and regional 
or sectional diversities; to renounce practices derogatory to the 
dignity of women;

(f) 	to value and preserve the rich heritage of our composite culture;

(g) 	to protect and improve the natural environment including forests, 
lakes, rivers, wild life and to have compassion for living creatures;

(h) 	to develop the scientific temper, humanism and the spirit of inquiry 
and reform;

(i) 	 to safeguard public property and to abjure violence;

(j) 	 to strive towards excellence in all spheres of individual and 
collective activity so that the nation constantly rises to higher levels 
of endeavour and achievements;

(k) 	who is a parent or guardian to provide opportunities for education 
to his child or,  as the case may be, ward between age of six and 
fourteen years.



CHILDREN'S RIGHTS
Dear Children,

Wouldn’t you like to know about your rights? Awareness about your 
rights will inspire and motivate you to ensure your protection and 
participation, thereby making social justice a reality. You may know 
that a commission for child rights is functioning in our state called the 
Kerala State Commission for Protection of Child Rights.
Let’s see what your rights are:
• 	 Right to freedom of speech and 

expression.

• 	 Right to life and liberty.

• 	 Right to maximum survival and 
development.

• 	 Right to be respected and accepted 
regardless of caste, creed and 
colour.

• 	 Right to protection and care 
against physical, mental and 
sexual abuse.

• 	 Right to participation.

• 	 Protection from child labour and 
hazardous work.

• 	 Protection against child marriage.

• 	 Right to know one’s culture and 
live accordingly.

• 	 Protection against neglect.

• 	 Right to free and compulsory 
education.

• 	 Right to learn, rest and leisure.

• 	 Right to parental and societal 
care, and protection.

Major Responsibilities

	 Protect school and public 
facilities.

	 Observe punctuality in learning 
and activities of the school.

 	 Accept and respect school 
authorities, teachers, parents and 
fellow students.

 	 Readiness to accept and respect 
others regardless of caste, creed 
or colour.

Contact Address
Kerala State Commission for Protection of Child Rights

'Sree Ganesh', T.C.14/2036, Vanross Junction
Kerala University P.O., Thiruvananthapuram-34, Phone : 0471 - 2326603

 E-mail : childrights.cpcr@kerala.gov.in, rte.cpcr@kerala.gov.in  
 Website : www.kescpcr.kerala.gov.in

Child Helpline - 1098, Crime Stopper - 1090, Nirbhaya - 1800 425 1400
Kerala Police Helpline - 0471 – 3243000/44000/45000

online R.T.E Monitoring : www.nireekshana.org.in
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